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Francisco Santos, Vice-President, Colombia 

 

“There are critical discussions to be had about competitiveness whilst upholding human rights which forces 

the need for a permanent constructive dialogue with all employees, in all sectors and with all stakeholders.   

There has been increased pressure generated by power of globalisation.” 

 

 

Bennett Freeman, Senior Vice President, Sustainability Research and Policy, Calvert Investments and 
Former US Deputy Assistant Secretary for Democracy, Human Rights and Labor 

 

“It’s fair to say few democracies have faced such grave human rights challenges as Colombia over last two 

decades.  Colombia has been a laboratory for the key issues that business has to address with respect to its 

roles and responsibilities when it comes to human rights ... I think Colombia is emerging not only as an 

example of serious problems but more positively as a model for innovative solutions. 

 

 

Angela Rivas Gamboa, Head of Business and Peace Building, Fundación Ideas para la Paz (FIP) 

 

“Emerging issues in Colombia for business include land, which for many is the core of the conflict in 

Colombia. More specifically, internal forced displacement, the volume of abandoned land, and informality in 

land tenure are relevant here. Companies are now facing the effects of a series of unresolved issues 

regarding land tenure in the midst of multiple  

conflicts that so often have resorted to violence.” 

 
 
 

Carlos Franco, Director of the Vice-President’s Office Programme on Human Rights 

 

 “We have to overcome the idea that human rights is simply a declaration of principles – that it is a 

declarative issue or a way to put out fires.  Those opinions have to be overcome and we must understand 

that human rights are a question of the culture of the business” 

 

 

 

 

 

 

 

 



 

CONTACTS 

 

 

 

 

Katryn Wright 

Programme Manager 

Global Business Initiative on Human Rights  

   katryn.wright@global-business-initiative.org 

www.global-business-initiative.org  

 

 

 

 

 

 

 

 

Angela Rivas Gamboa 

Head of Business and Peace Building 

Fundación Ideas para la Paz 

arivas@ideaspaz.org 

www.ideaspaz.org  

 

 

 

 

 

 

Diana Chávez 

Director 

Centro Regional Para America Latina y el Caribe  

en Apoyo al Pacto Mundial de Naciones Unidas 

   dchavez@andi.com.co 

www.unglobalcompact.org   

 

 

 

 

 

Kelly Scott 

Programme Support Manager 

Institute for Human Rights and Business  

 kelly.scott@institutehrb.org 

www.institutehrb.org 

 

http://www.ideaspaz.org/


 

 

 

 

 
 

 

CONTENTS 

 

INTRODUCTION .............................................................................................................................................1 

THEMES .........................................................................................................................................................4 

WELCOME PANEL ..........................................................................................................................................5 

KEYNOTE SPEECH ............................................................................................................................... 6 

GLOBAL AND LOCAL PERSPECTIVES ..............................................................................................................7 

BUSINESS AND HUMAN RIGHTS – DOING BUSINESS IN COLOMBIA ....................................................... 9 

PARTNER REFLECTIONS ..................................................................................................................... 12 

CONVENERS ..................................................................................................................................... 14 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

INTRODUCTION 
 

Since the 1990s, corporations have been faced with an increasingly rigorous and intense imperative to earn 

their license to operate from a range of stakeholders. Business leaders around the world now realise that 

responsible and sustainable business is far beyond legal compliance and philanthropy.  

Issues finding their way into Colombian boardrooms include opposition to land use and acquisition by 

industry, competition over scarce natural resources, operating in conflict affected areas, creating diverse 

and dynamic work forces, accessing new markets and sources of capital, and achieving sustainable labor 

relations.  

In this context, companies in all industries are seeing that international human rights offer a highly practical 

and socially legitimate framework for corporate responsibility. This approach can enable business to align 

themselves with international policy norms, multinational and national regulatory frameworks, the 

aspirations of employees and workers, the creation of a socially sustainable business environment, new 

business opportunities and the diverse lives of stakeholders.  

On 24 May 2010 an event was organised by the Fundación Ideas Para La Paz, the Global Business Initiative 

on Human Rights (GBI), El Centro Regional para América Latina y el Caribe en apoyo del Pacto Mundial de 

las Naciones Unidas and the Institute for Human Rights and Business to address the topic of business and 

human rights.  The event aimed to offer business leaders from all sectors the chance to:  

 

 Understand the macro trends, drivers and imperatives for integrating human rights into business 

strategy and management 

 Hear how corporate respect for human rights has led to practical and efficient responses to social and 

environmental challenges 

 Identify shared needs and strategies to play a stronger role in the national, regional and international 

debate on human rights in a business context. 

The group of 64 participants and speakers on the day included Senior Business Leaders (44 participants), 

the Colombian Government (6 representatives), the United Nations (4 representatives), and Civil Society 

(10).  

 

REGIONAL POLICY AND PRACTICE CONTEXT 
 
Since the 1990s, corporations have been faced with an increasingly rigorous and intense imperative to earn 
their license to operate from a range of stakeholders. Business leaders around the world now realize that 
responsible and sustainable business is far beyond legal compliance and philanthropy.  Issues finding their 
way into Colombian boardrooms include opposition to land use and acquisition by industry, competition 
over scarce natural resources, operating in conflict affected areas, creating diverse and dynamic 
workforces, accessing new markets and sources of capital, and achieving sustainable labour relations. 
 
In this context, companies in all industries are seeing that international human rights offer a highly practical 

and socially legitimate framework for corporate responsibility. This approach can enable business to align 

themselves with international policy norms, multinational and national regulatory frameworks, the 
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aspirations of employees and workers, the creation of a socially sustainable business environment, new 

business opportunities and the diverse lives of stakeholders. 

 

GLOBAL CONTEXT 
 

In all countries around the world, an essential part of the individual and collective corporate responsibility 

journey is the interface with emerging international frameworks and approaches, such as the UN Global 

Compact, the Global Reporting Initiative and the Millennium Development Goals. Such interaction 

contributes to fostering a vision of an ethical, fair and sustainable globalization that works for all.  

 

The past decade has seen increased consensus, clarity and commitment about human rights in a business 

context. This is due to many major corporations seeing the clear, long- term business case for respecting 

human rights, including improved risk management; improved compliance; efficiency gains; reduced 

operational disruption; sustained license to operate; new business models; and access to capital and 

markets.  As well as escalating commitment to the UN Global Compact – where human and labour rights 

content is strong – companies all over the world have practices to share that relate to human rights (even if 

they are not labelled as such).  
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THE UN PROTECT, RESPECT, REMEDY FRAMEWORK 

 

The work of the UN SRSG Professor John Ruggie has also been instrumental in building momentum in this 

area of corporate responsibility. The audience at the Roundtable heard an explanation of the three pillars 

of the Protect, Respect and Remedy framework and were able to pose questions to his UN Special Advisor 

Gerald Pachoud about the framework.  The following excerpts are taken from an interview with Professor 

Ruggie.1 

 

The State Duty to Protect  

 
“When States sign up to international human treaties they take on certain obligations.  The obligations vary 
in the precise language depending on whether it is the Covenant on Civil and Political Rights or the Covenant 
on Economic, Social and Cultural Rights, or whether it’s an anti-discrimination Convention ... there is one 
common element in human rights law that all states sign  up to - and that is that they will ensure the 
enjoyment of those rights of people within their jurisdiction or within their territory….Ensuring the 
enjoyment of rights means that States promise to protect people within their jurisdiction from abuse not 
only by the states themselves, but by third parties.  That includes business.  States know that they have this 
legal duty, but because the issue is relatively new they haven’t fully thought through what the implications 
are.  We’ve worked with States to help think through what the implications are.”  
 
The Corporate Responsibility to Respect 

 
“Currently under international human rights law companies don’t have legal duties.  If there is one norm 
that enjoys universal acceptance even by companies themselves it is that companies have the responsibility 
to respect rights which means not interfering with the rights of others as they go about their business.  
Every voluntary initiative that companies have adopted, ILO conventions, OECD Guidelines for Multinational 
Enterprises, etc recognise and affirm that companies have a responsibility to respect human rights.  So what 
we’ve done there is to say ‘ok we take you at your word that you respect human rights, but how do you 
know you respect human rights? Do you actually have systems in place that would allow you to 
demonstrate to yourselves let alone anyone else’.”       
 
Access to Remedy 

 
“No system of prevention is perfect – things are going to go wrong: you need remedies for when they do 
and there we’ve examined voluntary grievance mechanisms that companies can set up themselves, 
particularly large footprint companies that have a big impact in communities….Why would they want to do 
that? Because most major human rights violations didn’t start out that way, we discovered – they start out 
as minor grievances that get ignored, and if a company had a mechanism, a place where the community 
could come with their grievances, they could head off the escalation of minor grievances into major 
confrontations that may lead to major human rights violations….But then of course, there’s the state side, 
and that has to do with judicial systems and access to judicial systems. The access part is horrendously 
difficult for the kinds of victims that you typically see in this area, who are either workers – where freedom 
of association is forbidden, they don’t have built-in grievance mechanisms, there’s no state labour inspector 
they can complain to; there ought to be the judicial or quasi-judicial mechanisms – or you’re talking about 
poor communities, indigenous communities, for example, who don’t have access to the kind of law firms 
that, in fact, I’ve been privileged to have access to.” 

                                                
1 Quotations from Professor John Ruggie replicated with the kind permission of the International Bar Association from:  

>>>http://www.ibanet.org/Article/Detail.aspx?ArticleUid=422B3B1F-4C73-4500-B8E1-1D45EA992A71  
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THEMES 
 

 
THEME ONE - CHALLENGES AND RESPONSES 

 

The unique challenges and responses to human rights issues for businesses in Colombia, and Colombia as 

an emerging model for business and human rights solutions. As part of this, the shift from philanthropic 

corporate activities to addressing accountability, in corporate structures and with concrete steps and 

commitment by the Government and business. 

 

THEME TWO - THE BUSINESS CASE 

 

There is a need for a level playing field by all actors.  Also, the need to expand the vision of business and 

human rights in Colombia beyond, and make advances in, the non-extractive sectors (noting the 

constitutional definition given under Articles 33 and 34 and the development of the Colombian Guidelines 

(www.business-humanrights.org/Documents/Guias Colombia). 

 

THEME THREE – KEY ISSUES 

 

Key issues facing companies operating in Colombia including Indigenous rights, land, water, conflict and 

freedom of association.  Although these issues were a recurring theme throughout the roundtable, they 

were not the sole issues affecting business in Colombia, and many spoke on other issues challenging for 

business operations in the country e.g. non-discrimination.   

 

THEME FOUR – DIALOGUE 

 

The pressing need for a constructive dialogue between corporations and civil society, in particular worker’s 

organisations and trade unions. How do human rights norms and standards apply to those who play the 

role of holding corporations to account? Do these entities play on a level playing field? 

 

THEME FIVE - RESOURCES 

 

The need for greater access to tools and mechanisms for business, particularly the translation and adaption 

to local needs of existing materials and guidance.   
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WELCOME PANEL 
 

Welcoming comments were given by the event partners together with an outline of their work and interest 

in the area of business and human rights.  Maria Victoria Llorente, Director, Fundación Ideas para la Paz, 

John Morrison, Executive Director, Institute for Human Rights and Business, Mark Hodge, Director of the 

Global Business Initiative on Human Rights and Leon Teicher, President, Cerrejón all spoke of the 

significance of the event and the positive role business can and is playing in furthering human rights in 

Colombia.   

 

 

 

 

 

 

 

 

 

+ 

 

 

 

 

 

 

Key discussion points 

 

 The debate in Colombia has moved on from being related to corporate philanthropy to new discussions 

on business accountability.  Vice-President Santos outlined the encouraging figures for the percentage 

of profits earmarked for developing corporate accountability in Colombian companies. 

 Need for increased role of civil society.  

 Colombia as most advanced nation in integrating the Voluntary Principles. 

 Building common state objectives is a priority. 

 Critical discussions on retention of competitiveness whilst addressing human rights. 

 Increased pressure generated by power of globalisation. 

 Need for greater acceptance by new markets. 
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KEYNOTE SPEECH 
 

 

This session was hosted by Alexandra Guaqueta, 

Head of Social Standards and International 

Engagement, Cerrejón.  Opening remarks from 

Mark Hodge, Director of the Global Business 

Initiative on Human Rights provided the context 

for the event and the current state of play of 

business and human rights. The keynote speech 

was delivered by Francisco Santos, Vice-

President of Colombia. 

 

Francisco Santos, Vice-President, Colombia 

“The debate in Colombia has moved on from 

being related to corporate philanthropy to new 

discussions on business accountability and there 

are very encouraging figures released showing the percentage of profits earmarked for developing 

corporate accountability in Colombian companies. It should also be noted that Colombia is the most 

advanced nation in the integration of the Voluntary Principles on Security and Human Rights. ... Civil Society 

must play a more constructive role in this debate to further human rights in the business field. Building 

common State objectives is also a priority.”   

 

“There are critical discussions to be had about competitiveness whilst upholding human rights which forces 

the need for a permanent constructive dialogue with all employees, in all sectors and with all stakeholders.  

There has been increased pressure generated by power of globalisation.” 

 

“There should be pressure for greater acceptance of the need to integrate human rights into business 

practices by new markets to ensure our foreign trade policy can align with our national practices.”  
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GLOBAL AND LOCAL PERSPECTIVES 
 
This session focused on the policy context, trends and emerging expectations on business to respect human 
rights. The aim of the session was to explore the wider context within which business in Colombia is 
operating today. The session was moderated by Alexandra Guaqueta, Head of Social Standards and 
International Engagement, Cerrejón and included Gerald Pachoud, Special Advisor to the UN Special 
Representative to the Secretary General on Business and Human Rights, Salil Tripathi, Director of Policy, 
Institute for Human Rights and Business, Bennett Freeman, Senior Vice President, Sustainability Research 
and Policy, Calvert Investments and Former US Deputy Assistant Secretary for Democracy, Human Rights 
and Labor, and Jose Rafael Unda, President's Advisor on Mining, Infrastructure and Oil. 

  

Key discussion points 
 

 The panel addressed the following questions: What should governments do? What should companies 

do? Why is the realisation of human rights critical to business? Colombia as an emerging model for 

business and human rights solutions; and Colombian Government perspectives on human rights and 

business. 

 

 Discussed the business case for integrating human rights into business. 

 

 Explored the key human rights issues and human rights flash-points facing businesses globally and in 

Colombia. 

 

 Reviewed the mandate and findings of the UN SRSG Professor John Ruggie and an introduction to the 

Protect, Respect, Remedy framework. 

 

 Discussed the need for and benefits of transparency (moving away from “naming and shaming” to 

“knowing and showing”) and the potential risks faced in conducting due diligence being out weighted 

by the benefits of compliance, transparency and knowledge of the full spectrum of social-related risks.  

Explored challenges faced and action by government and business in Colombia.  The importance of 

action on the ground in improving the climate for trade and investment.    
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Gerald Pachoud, Special Advisor to the UN Special Representative to the Secretary General  
on Business and Human Rights 
“We have to forget about the term “human rights” as it has become very politicised.  We should think 
instead about people moving away from fear.  Moving away from want and need is what human rights is all 
about.  Human Rights are not a complex thing - they are about living with dignity and stability.  The interest 
we have in the term human rights is that it is the codification for all people around the world to respect 
standards – a benchmark for dignity”.   

“The mandate has been trying to get out of the triangle of Geneva, New York, London to encounter 
experiences, feelings and reactions of people in other areas such as Africa, Latin America and Asia.  What 
we found was a unanimous wish to respect human rights, but what did that mean?  We needed to find the 
right framework and in 2008 the Protect, Respect, Remedy framework was put forward to this end.  The 
framework portrays a shift in responsibility back to governments for human rights, such as provision of 
education and health, but a universal responsibility for companies to respect (not infringe upon) the rights 
of others.  The third pillar of the framework is access to better remedies - the need for communities to 
effectively voice, and have remedied, their grievances about company impacts. ... How does a company 
show that it respects human rights?  The answer is to conduct due diligence. John Ruggie speaks of the need 
to move away from ‘naming and shaming’ to ‘knowing and showing’.”    

“People sometimes question whether human rights is too broad for a business context, but the breadth of 
human rights allows you to cover all risks.  Yahoo! would not have seen privacy as a major issue for 
example.  Human rights allow you to cover the full spectrum of social related risks.  It is not too wide.  On 
the contrary, by using the label ‘human rights’ you can set some boundaries on stakeholder expectation.  
CSR and philanthropy has no limits to breach - if you adopt a human rights risk management approach you 
can set clear boundaries.  It’s a big responsibility, but not an infinite one”. 

 
Salil Tripathi, Director of Policy, Institute for Human Rights and Business 
 “Bad things do happen - forced labour and eviction, illicit payments, abuse by security forces, violation of 
sanctions, providing the means to kill, misuse of company assets .... In conflict companies may not always 
have control. But they cannot escape responsibility. Companies want to use resources and want to have 
security - but they have to respect rights.”   

“Good things can happen – if we look at Occidental, Cerrejón and others we see examples of how due 
diligence can be conducted and affect change for the good – the same applies to processes and voluntary 
initiatives such as the Kimberly Process in the diamond industry and Equator Principles in the finance 
sector.”   

 
Bennett Freeman, Senior Vice President, Sustainability Research and Policy, Calvert Investments and 
Former US Deputy Assistant Secretary for Democracy, Human Rights and Labor 
“It’s fair to say few democracies have faced such grave human rights challenges as Colombia over last two 
decades.  Colombia has been a laboratory for the key issues that business has to address with respect to its 
roles and responsibilities when it comes to human rights ... I think Colombia is emerging not only as an 
example of serious problems but more positively as a model for innovative solutions.  As progress continues 
to be made and international recognition of that progress grows, relationships with donors can improve 
along with the climate for trade and investment”.   

 
Jose Rafael Unda, President's Advisor on Mining, Infrastructure and Oil 
 “In Colombia the business responsibility to respect human rights has a constitutional definition in Article 33 
and Article 34 of the Charter where the connection between business and human rights is clear and 
transparent and to be respected by every company.  Democratic security is security for everyone not just for 
some. ... A key aspect of responsible investment is being aware of the other people. An investment of an 
extractive company for instance will impact the interest of the citizens.  In making investments, companies 
should be responsible and aware of the negative and positive effects they may have on others”.  
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BUSINESS AND HUMAN RIGHTS - DOING BUSINESS IN COLOMBIA 
 
This session offered the opportunity to hear about practical responses to concrete, often entrenched, 
challenges that have been faced by business leaders in Colombia. Speakers discussed specific instances 
faced at facility or factory level and explained what a human rights approach has added to their response 
and future plans. This session was moderated by Luis Fernando De Angulo, TRUST Building Consultants 
and Member of the Board at the Institute of Human Rights and Business.  The panel included Leon 
Teicher, President, Cerrejón, Luis Fernando Rico, President, ISAGEN, Pablo Largacha, Public Affairs & 
Communications Latin Center Business Unit, The Coca-Cola Company, and Angela Rivas Gamboa, Head of 
Business and Peace Building, Fundación Ideas para la Paz (FIP). 
 

 
Key discussion points  
 

 The panel covered the issues of conflict and human rights grievances; business and human rights issues 
beyond security; human rights and the workplace; emergent topics in business and human rights in 
Colombia. 
 

 Cerrejón spoke of the challenges of operating in vulnerable areas; the need for a clearly enforceable 
compulsory human rights policy; the use of tools such as the VPs and IFC guidelines; the use of 
grievance mechanisms; ensuring rigorous due diligence throughout operations; and  the value of strict 
agreements with law enforcement.  “We do what we do in this area for a reason – moral obligation”.  
 

 ISAGEN discussed how human development is focussed on profitability, social development and 
environmental protection.  “Human Rights are the articulating factor among those three factors of 
growth.  That has led the company to be inspired by two international initiatives: the UN Global 
Compact and the Millennium Goals”.    
 

 The Coca-Cola Company stressed the need for fair treatment of all employees as part of the license to 
operate and brand protection, and the need for increased awareness of what happens along the 
company's supply chain.  The company cited two key cases - Union member assassinations by illegal 
paramilitary and guerrilla groups in Colombia and child labour in sugar cane harvesting in El Salvador.   
In order to address situations such as these, the company built on existing policies and procedures to 
create a Workplace Rights Policy and a Human Rights Statement which are used with every entity 
where it has a majority share participation, and also strengthened its Supplier Guiding Principles, which 
apply to all direct and indirect suppliers to the Coca-Cola system.  
   

 FIP’s work in this area has identified that key issues are not always being framed as part of human 
rights and are therefore isolated in departments that cannot exert any influence.  Emerging key issues 
include land (for many this is at the core of the conflict) and extortion (arming illegal groups) and the 
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extent to which companies can be said to be victims or accomplices. Another trend is the role of 
corruption of states in preventing the ability to protect human rights. 

 

Leon Teicher, President, Cerrejón 

 “It is possible to promote human rights - we as a Colombian company have done that.  We have a clear 

human rights policy which is compulsory. We have tools like the Voluntary Principles (VPs) and the 

International Finance Corporation (IFC) Guidelines.  In Cerrejón we also use our grievance mechanism, 

ensure due diligence is conducted with rigour, make agreements with law enforcement agencies and report 

to NGOs on possible threats people think they are receiving from groups.  Transparency has helped us 

enhance our protection for those that feel their rights have been violated. ... It would be useful to have 

international certification, and to aim for a level playing field – a set of rules of the game that key players 

should be committed to. Unions need to have the same rules of the game for all of us to continue to take a 

big step forward in the implementation of human rights. 

“We have to understand that we ourselves have to work to change our general attitude in implementing a 

self regulation system and control to prevent illegal mining for instance.  We do what we do in this area for 

a particular reason – our moral obligation. ... We have to do some work in educating people, teaching the 

‘gospel’, abiding by the law and honouring the law.  Another issue behind the questions needs to be laid on 

the table and that is the assumption that the company is ‘bad’.  We have two battles with that – the fight 

against the notion that all companies violate human rights and that multinationals are automatically 

associated with a particular style of behaviour.  In the dialogue we look for balance.  If you are looking for a 

level playing field then I think those issues have to be addressed.”   

Luis Fernando Rico, President, ISAGEN 

“It is important to establish what we understand by human rights.  Business has stakeholders and therefore 

businesses have to have ethical principles for extending well-being to those other groups impacted by their 

existence.  In ISAGEN, sustainable human development focuses on profitability, social development and 

environmental protection.  Human rights are the articulating factor among those three factors of growth. ... 

We need to create and strengthen trust with business and civil society.  We need to understand the 

peculiarities of each region here.  Comprehensive social political studies are important before any projects 

are undertaken. ... Many times you run into people who say human rights are leftist or rightist - to begin 

with that is a problem.  Many times in the agreements we handle the question arises “so you agree with 

those who are accusing us”?  We need to make them understand that it´s a two sided coin.  This helps allow 

for visibility so we can face issues. ... There is increasing will in the corporate world to tackle these issues 

and there is awareness. I think that we have come closer little by little on aspects such as trade 

associations.”   

Pablo Largacha, Public Affairs & Communications Latin Center Business Unit, The Coca-Cola Company 

“In 2005 the Company developed or improved a set of policies and processes, which today are at the core of 
the way we do business in every country where we operate ... our Human Rights Statement and Workplace 
Rights Policy, which are guided by international human rights principles ...[and] our Supplier Guiding 
Principles, which emphasize to all direct and indirect suppliers to the Coca-Cola system the importance of 
responsible workplace policies and practices that comply, at a minimum, with applicable local labor laws .... 
Today, the strategy The Coca-Cola Company employed in Colombia and El Salvador has garnered positive 
results, and has inspired conversations within its global business system about scaling-up such efforts to 
include other countries facing similar challenges. Anti-Union violence in Colombia, or child labor in the sugar 
farms of El Salvador, just to name two workplace issues, are not externalities that businesses like ours can 
ignore or just leave in the hands of Government. By internalizing these issues, Coca-Cola is now being able 
to transform relationships – some of which had traditionally been adversarial- into cooperative 
partnerships.” 
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“No company can tackle these problems acting on its own. In our case, by joining efforts with government 
authorities, other companies and organizations such as Fundación Ideas para la Paz, the UN Global 
Compact, the Global Business Initiative on Human Rights, the Institute on Human Rights and Business and 
the International Labor Organization, we have been able to establish clear priorities, set measurable goals 
and take decisive action to address these challenges.” 

Angela Rivas Gamboa, Head of Business and Peace Building, Fundación Ideas para la Paz (FIP) 

“FIP’s work in this area has identified that key issues are not always being framed as part of human rights 
and are therefore isolated in departments that cannot exert any influence. … Emerging issues in Colombia 
for business include land, which for many is the core of the conflict in Colombia. More specifically, internal 
forced displacement, the volume of abandoned land, and informality in land tenure are relevant here. 
Companies are now facing the effects of a series of unresolved issues regarding land tenure in the midst of 
multiple conflicts that so often have resorted to violence. … Another trend is the role played by corruption in 
States which prevents the company’s ability to protect human rights.  Maybe we should highlight the 
question of how much the private sector can do in promoting practices against corruption.   
"A third emerging issue relates to corruption and the capture of the State by illegal actors, which are 
understood as factors that prevent the State to effectively protect human rights and pose significant 
challenges to companies when seeking to respect human rights and promote human rights respect. ... In 
addressing these emerging topics, is worth posing the question of how much can business do to address 
them and deal with them within the business and human rights framework" 

Luis Fernando De Angulo, member of the board at the Institute of Human Rights and Business 

“We have faced a left verses right ideological confrontation of human rights, and the establishment has to a 

great extent given away the human rights cause despite human rights being a founding element of liberal 

democracies and capitalism.  The paradox in Colombia is that human rights are perceived as a leftist banner 

flag and security is perceived as an interest of the right. It is seldom that the interdependence of both is 

highlighted. ... Another key issue in the integration of human rights in business is how this agenda is 

communicated to smaller companies. The interaction of smaller firms with the global agenda is weaker and 

normally they do not have the resources to track topics like human rights, notwithstanding the impacts and 

influence of these firms in the more vulnerable sectors of the population. We need to address questions like 

‘What barriers do we have to remove to be able to pass these messages on to those who don´t normally 

engage with the human rights community?’ What needs to be done to assist them in raising awareness and 

preparation so that in 3 years’ time they reach a position of constructive engagement that we all are 

looking for”. 
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PARTNER REFLECTIONS 
 

A short dialogue offered a chance for participants to share challenges, questions and needs in relation to the 

integration of human rights into business practice in Colombia, exploring the barriers, ongoing questions and 

challenges; what business leaders need; what is needed from governments, peers in industry, business 

networks/associations, civil society, investors, etc. The session was moderated by Kathryn Dovey, Director, 

Global Business Initiative on Human Rights.  

 

This panel included reflections on the day from Angela Rivas Gamboa, Head of Business and Peace Building, 

Fundación Ideas para la Paz, Luis Fernando De Angulo, TRUST Building Consultants and member of the 

board at the Institute of Human Rights and Business and Diana Chavez - El Centro Regional para América 

Latina y el Caribe en apoyo del Pacto Mundial de las Naciones Unidas.  

Angela Rivas Gamboa, Head of Business and Peace Building, Fundación Ideas para la Paz 

 “One of the things lacking is a diversity of relevant materials in Spanish.  For many companies this provides a 

barrier to integration, coupled with the fact that these materials are adapted to another reality.  They don’t 

correspond to what we see day to day in Colombia”. 

 

A closing speech was delivered by Carlos Franco, Director of the Vice-President’s Office Programme on 

Human Rights. 

Carlos Franco, Director of the Vice-President’s Office Programme on Human Rights 

 “There is strong polarisation – Colombian NGOs have the capability to move US Congress and European 

Parliament.  No state has this ability.  At the Government level –there is a lack in cohesion between laws and 

practice.  You have to formulate a cohesive policy.”  

“We have to overcome the idea that human rights is simply a declaration of principles – that it is a 

declarative issue or a way to put out fires.  Those opinions have to be overcome and we must understand that 

human rights are a question of the culture of the business” 

Carlos Franco outlined seven key issues to address what is at stake for business: 

 Polarisation of certain sectors of civil society and the idealisation of human rights in Colombia. 

 The challenge of operating in conflict-affected areas and the lack of commitment in the non-extractive 

sectors to engage in this debate.  

 Importance of Indigenous ancestry and Colombia as a signatory of Agreement 169 of the ILO 

Convention.   

 The need for business to overcome the international community’s idea that business is responsible for 

all social imbalances.   

 The need for clearer policy that will favour dialogue with civil society. 

 Changing the concept we have of human rights in businesses.   
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 The overarching need for companies to mitigate what is unavoidable and prevent what is avoidable.   

 

FIP stressed the barriers to integration given the need for translation and adaption to local situations of 

existing materials and tools.   

 

Moving forward after the event, the following actions were noted:  

 

 Regional Business Roundtable in 2011:  There will be a business roundtable session for Latin American 

companies lead by the Global Business Initiative on Human Rights together with the event partners in 

early 2011. The UN Global Compact Regional Centre will play the lead convening role in this session. 

Colombian businesses are encouraged to express interest in participating, speaking at the event and/or 

contributing case studies. 

 

 Adapting Resources: The adaptation and translation of Business and Human Rights tools/resources for a 

Latin American context will be led by the knowledge development arm of Trust Building Consultants, 

Companies are invited to participate in a working group on this item with the intent to launch revised 

materials at the GBI Roundtable in 2011.  

 

 Ongoing Colombian leadership: Fundación Ideas para la Paz and the Colombian Global Compact 

Network among others, will continue to provide guidance and thought-leadership in the area of Business 

and Human Rights. The UNGC Colombia Network already has plans for Business and Human Rights 

training courses in the second half of 2010.  
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The Global Business Initiative On Human Rights (GBI) is a unique business-led initiative focused on 
advancing human rights in a business context around the world. GBI currently has 14 corporate members 
from 11 industry sectors with representation from Latin America, Asia, Europe, North America, and the 
Middle East. Through core group work streams and business outreach activities GBI seeks to build a global 
community of business leaders sharing good practices, identifying barriers to corporate respect for human 
rights in diverse contexts and inputting into international policy developments. Our work plan is divided 
into two parallel tracks. First, Action-Learning around the UN Guiding Principles on Business and Human 
Rights; and second, Business Awareness and Capacity Building through events and workshops in emerging 
and developing markets. GBI works in collaboration with the UN Global Compact Office and is supported by 
the Swiss Government. For more information visit: www.global-business-initiative.org 
 

 

 

 

 

 

 

 

Fundación Ideas Para La Paz (FIP) is a non-profit centre for independent thinking, created in 1999 by a group 

of Colombian businessmen. Its mission is to contribute with ideas and proposals to overcome the armed 

conflict in Colombia and building sustainable peace, with support from the business sector.  FIP's work is 

founded on the belief that the Colombian conflict must end with a negotiation or a series of peace 

negotiations, which will require proper preparation and technical assistance if they are to be successful. 

Meanwhile, it is clear that the conflict in its politico-military dimension is in the process of transformation. It 

is therefore essential to understand these new scenarios to deal creatively and effectively with the new 

challenges that arise. In order to meet these challenges, the Foundation has expanded its agenda and has 

strengthened its capacity for analysis and management with a strong academic and professional team 

working on the following four areas: 

•         Dynamics of conflict and peace negotiations. 
•         Post-conflict peace building. 
•         Business and conflict. 
•         Security and defence studies. 
 
For more information visit: www.ideaspaz.org  
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El Centro Regional para América Latina y el Caribe en apoyo del Pacto Mundial de las Naciones Unidas is an 

initiative of 10 CEOs and 2 Colombian associations (later joined by a Mexican company and a Canadian 

company).  It is a non-profit organisation that works in association with the Global Compact and its principles 

as a strategy for economic and social development from a perspective of the conditions and characteristics 

of the region, and to act in favour of implementing this initiative in Latin America. Its objectives are:  

• To be the forum to generate ideas and innovative tools that will strengthen Social Responsibility (SR) in 

Latin America and the Caribbean in the framework of the Global Compact Principles, the Millennium 

Development Goals (MDGs) and other initiatives promoted by the Global Compact Office. 

• Contribute to the consolidation, from the perspective of the Global Compact, a Latin American and 

Caribbean agenda for competitiveness and project the international context as a strategy for 

development. 

• Contribute to the strengthening of local support networks and support the Global Compact in the 

professionalization of its focal points. 

• Contribute to and facilitate the strengthening of the Global Compact agenda in the region. 

• Facilitate and promote joint initiatives aimed at strengthening SR in Latin America and the Caribbean. 

 

For more information visit: www.centroregionalpmal.org 

 

 

 

 

 

 

The Institute for Human Rights and Business (IHRB) is dedicated to being a global centre of excellence and 

expertise on the relationship between business and internationally proclaimed human rights standards. 

 

It provides a trusted, impartial space for dialogue and independent analysis to deepen understanding of 

human rights challenges and issues and the appropriate role of business. The Institute seeks to address 

problems where the law may be unclear, where accountability and responsibility may not be well-defined, 

and where legitimate dispute settlement mechanisms may be non-existent or poorly-administered. 

 

The Institute works to raise corporate standards and strengthen public policy to ensure that the activities of 

companies do not contribute to human rights abuses, and in fact lead to positive outcomes. 

 

For more information visit: www.institutehrb.org 
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[ T Y P E  T H E  S U B T I T L E ]  

HEADING 1|ONE 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of 

your document.  You can use these galleries to insert tables, headers, footers, lists, cover pages, and 

other document building blocks.  When you create pictures, charts, or diagrams, they also coordinate 

with your current document look. On the Insert tab, the galleries include items that are designed to 

coordinate with the overall look of your document.  You can use these galleries to insert tables, 

headers, footers, lists, cover pages, and other document building blocks.  When you create pictures, 

charts, or diagrams, they also coordinate with your current document look 

Heading 2|two 

You can easily change the formatting of selected text in the document text by choosing a look for the 

selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using 

the other controls on the Home tab. Most controls offer a choice of using the look from the current 

theme or using a format that you specify directly. 

The quote is bold and distinctive. The galleries include items that are designed to 

coordinate with the overall look of your document. 

On the Insert tab, the galleries include items that are designed to coordinate with the overall look of 

your document.  You can use these galleries to insert tables, headers, footers, lists, cover pages, and 

other document building blocks.  When you create pictures, charts, or diagrams, they also coordinate 

with your current document look.. 

Heading 3|three 

To change the overall look of your document, choose new Theme elements on the Page Layout tab.  To 

change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.  

Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can always 

restore the look of your document to the original contained in your current template. 

You can easily change the formatting of selected text in the document text by choosing a look for the 

selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using 

the other controls on the Home tab. Most controls offer a choice of using the look from the current 

theme or using a format that you specify directly. 

 

  

18




